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About this Manual 

The Oracle Financial Services Retail Performance Analytics (OFSRPA) focalizes on 
Summary performance of the LOBs and overall profitability, Portfolio mix, LOB specific 
profitability reports to be analyzed against key dimensions like customer segments, product 
family, region, branch, risk scores etc, Product holdings and Relationship depth across the 
LOBs, Customer Trends across performance drivers like Sales, Balances, Deposits, Product 
subscriptions (revenue services), Credit scores and delinquency bands, losses, etc, Wallet 
Share analysis and customer lifetime value, Efficiency of investments (like marketing, branch, 
channel etc) over time. 

Audience 

This Manual is meant for use by the Oracle Financial Services Analytical Applications 

Infrastructure (OFSAAI) System Administrator. It provides step-by-step instructions necessary 

for installing the OFSRPA v6.0.2 Product.  

Scope 

This manual provides a step-wise instruction to install OFSRPA Product in an existing 

OFSAAI hosted in Oracle 11g R2 (11.2.0.2.0) environment. 

Organization of the Manual 

The Installation Manual is organized into the following chapters. 

o Pre-Requisites section identifies the hardware and base software environment that 

is required for a successful installation and functioning of OFSAAI.  

o Pre-Installation Activities section details the pre-installation activities 

o OFSRPA v6.0.2.0.0 Installation section details the step-by-step instruction on the 

various installation options. 

o Post installation Activities section details the steps that are required to be 

performed after a successful installation of the Oracle Financial Services Analytical 

Applications Infrastructure Solution. 

Conventions Used in this Manual 

References to sections or chapters in the manual are displayed in Italics.  

Screen names are displayed in the following manner: 

Introduction screen 

Options and buttons are displayed in Bold. 

Notes are displayed as follows: 

NOTE 

o It is important that the password should be 6 characters long. If you do not 

adhere to this pre-requisite, you will see a system message that reads Password 

must be at least 6 characters long. 
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Prerequisites 
The installation process requires certain environmental variables to be set prior to starting the 

installation. You must ensure that these requirements are met before starting the installation. 

You are requested to refer to the Release Notes for the latest updates on hardware or 

software requirements and the OFSAAI Installation Manual for the environment variables. 

Environment 

Installation of OFSRPA v6.0.2 Product requires the Oracle 11g R2 (11.2.0.2.0) version of 

OFSAAI v7.3.3.3.0, to be installed in either a single-tier or multi-tier environment.  It is implicit 

that all base software versions and patch levels required by Oracle Financial Services 

Analytical Applications Infrastructure 7.3 is available and adhered to. 

Note: 

o The Oracle Financial Services Retail Performance Analytics v6.0.2 installer 

download contains only the ERwin XML file that is required for uploading the 

model. This file is sufficient to install the v6.0.2 product. However, this XML file 

cannot be opened in the ERwin Data modeler tool and hence cannot be used for 

any data model customization. ERwin file is delivered as a patch and need to be 

downloaded separately. The reference bug/patch where ERwin file can be 

downloaded is 18630560. 

Prerequisites 

The Oracle 11g R2 (11.2.0.2.0) version of OFSAAI v7.3.3.3.0 and OBIEE 11.1.1.7.1 on any 

supported operating system once installed must be configured. 

Front-End Access 

o Internet Explorer 8.0/9.0 

o Java Plug-in 1.6.0_21 

o Acrobat Reader 8.0 

o The screen resolutions supported are 1024*768 and 1280*1024 

 NOTE 

o Ensure that Java Plug-in is enabled in the browser settings. 
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Pre-Installation Activities  
The following is the Pre Installation checklist to ensure the readiness to start installing 

OFSRPA Product: 

o Oracle Financial Services Analytical Applications Infrastructure v7.3.3.3.0 must be 

successfully installed on Oracle 11gR2 (RAC) (11.2.0.2.0). 

o If Infrastructure installation is on multitier environment, execute the following commands 

in the DB layer terminal  

chmod -R 777 < ftpshare folder >  

o Navigate to ftpshare folder and set the umask shown as below; this will make sure all the 

new files created will have 666 file permission.  

cd < ftpshare folder >  

umask 0000 

o The Config and application schema should be two distinct oracle database users. 

o Execute the following grants in config schema. Replace <ORACLE_USER> with 

application schema user. 

grant select on METADATA_MASTER to <ORACLE_USER> 

grant select on METADATA_ELEMENT_MASTER to <ORACLE_USER> 

grant select on METADATA_LOCALE_MASTER to  <ORACLE_USER> 

grant select on BATCH_MASTER to <ORACLE_USER> 

o Oracle database User for Application schema should have the below grants 

grant create session to <ORACLE_USER>; 

grant create ANY INDEX to <ORACLE_USER>;  

grant create PROCEDURE to <ORACLE_USER>;  

grant create SEQUENCE to <ORACLE_USER>;  

grant DEBUG CONNECT SESSION to <ORACLE_USER>;  

grant create TABLE to <ORACLE_USER>;  

grant create VIEW to <ORACLE_USER>;  

grant create trigger to <ORACLE_USER>; 

grant create type to <oracle_user>; 

grant select on sys.v_$parameter TO <oracle_user>; 

grant CREATE TYPE TO <_ORACLE_USER>; 

grant CREATE MATERIALIZED VIEW to < ORACLE_USER>; 

o Copy the entire OFSRPA v6.0.2 installer download directory to the server location 

(Including the DataModel directory). Provide read, write and execute permission to all the 

files present in this directory. 

o Specify the log file path and name in the log4j.xml. Update the “value” attribute marked in 

the following picture 
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Figure 1: Log4j.xml file configuration 

 

o Make sure the path given in the log4j.xml file has read/write/execute permission. 

o Execute the “config_table_privileges_for_application_user.sql” script in configuration 

schema. This file will be present inside $FIC_HOME directory. 

o Make sure FICServer is up and running before proceeding for installation.
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OFSRPA v6.0.2.0.0 Installation 
The OFSAAI Product comprises of components that are installed in Web, Application and 

Database layer.  Hence, if you have installed OFSAAI 7.3.3.3.0 in a multi-tier architecture, the 

OFSRPA Product installer must be invoked on each of the machines that host the OFSAAI 

tier.   

For a Single-tier installation, the installer is required to be invoked only once on the machine 

that hosts all the OFSAAI tiers.   

This section describes the installation process where the Three Product setup components 

are installed on separate machines in with the Product installation on separate machines. 

Machine A will be used to install Product Application Layer components, Machine B will be 

used to install Product Database Layer components, and Machine C will be used to install 

Product Web Layer components.  

NOTE 

o This section holds applicable if OFSAAI v7.3.3.3.0 is installed on Oracle 11g on separate 

machines A, B, and C respectively. 

o If a silent installation is required, refer to Silent Installation section. 
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Machine A – Product App Layer 

Step 1 

To begin OFSRPA product installation, execute Setup.sh. 

 

 

Figure 1: Installation Splash Screen 

Step 2 

 

Figure 2: Introduction Screen  

Upon invoking the installer, the Introduction screen will display the pre-requisites for 

installation. Ensure that the pre-requisites are satisfied before you proceed. 

Step 3 

Choose the log mode for this installer.  
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Figure 3: Log Mode Option Screen 

 

Step 4 

Provide the 9 digit Customer Identification number provided during the OFSAAI installation.  

 

Figure 4: Customer ID Input Screen 

 

 

Click Next to continue.
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Step 5 

The Pre Setup Information screen requests for setup information.   

Select the appropriate OFSAAI layer that has been installed on the machine.  

Example AppLayer 

 

Figure 5: Pre Setup Information Screen – Choose Layer to Install 

NOTE 

o For a single-tier OFSAAI v7.3.3.3.0 installation, you must select App Layer, Web 

Layer, and DB Layer. 

o For a multi-tier OFSAAI v7.3.3.3.0 installation, select the corresponding layer 

installed on the machine.   
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Step 6 

This panel seeks infromation on whether a new infodom has to be created or the existing 

infodom to be used for apps installtion. Choose the required option. 

 

Figure 6: Pre Setup Information Screen – Infodom type 

Click Next to continue. 

Step 7-i 

If the option New Infodom was chosen in the previous panel, then the following panel will be 

displayed seeking information of the following details to create infodom. 

Specify a DB name for the new infodom. Make a TNS entry with the DB name specified in the 

tnsname.ora file in the oracle server. 

Enter the newly created application schema user name, password, jdbc url in relevant fields. 

Click Next to continue. 

 

Figure 7: Database details for the new Infodom 
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Step 7-ii 

If the option New Infodom was chosen in the previous panel then the following panel will be 

displayed following the panel 7-i which will seek further information of the following details to 

create infodom. 

Specify the name and description for the new infodom to be created.  

Specify a segment name to be created. 

Note: Segment and INFODOM name should not exceed 10 Characters 

Also specify the Application server and database server log path for infodom maintenance (to 

be created). 

 

Figure 8: Infodom details for creation of new Infodom 

Note: 

o The OFSAAI user must have a role that is able to perform Add/Modify functions 

for OFSRPA metadata.   

Click Next to continue.  

Step 7-iii 

If the option New Infodom was chosen in the previous panel, then the following panel will be 

displayed following the panel 7-ii which will display the pre-infodom creation details. Check 

and verify all the details before proceeding to the next step. 
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Figure 9: Pre Infodom Creation Summary 

 

Click Next to continue creation of information domain. A new information domain will be 

created on clicking Next. 

Step 7-iv 

If the option Existing Infodom was chosen in the Step 6, then the following panel will be 

displayed which will prompt to select the infodom from list of infodoms present in the setup, 

enter segment code and enter the application schema’s TNS name. 

Segment code should not exceed 10 characters. 

 

 

Figure 10: Installation in Progress 

Step 8 

OFSRPA v7.4.2 data model is packaged as part of OFSRPA v6.0.2 product installer and will 

be installed as part of the upcoming steps, if required. 

The following screen prompts the user to opt for model upload process through installer. 
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Figure 11: Pre-Setup Information 

Clicking No implies that OFSRPA v6.0.2 model has been uploaded into information domain 

prior to this installation. 

Clicking Yes will proceed with the OFSRPA v6.0.2 model upload process as part of the 

installation. 

If the user selects Yes, Step 9 and 10 will be performed. 

If the user selects No, Step 9 to 10 will be skipped. 

Click Next to proceed. 

 

Step – 9 

The following panel prompts the user to choose whether the released version of Datamodel or 

the customized datamodel to be uploaded. 

If the user selects Released Data Model option, installer uploads the OFSRPA v6.0.2 data 

model that is packaged as part of the OFSRPA v6.0.2 product.  

If the user selects Customized Data Model option, installer allows the user to select the data 

model. Choose the required option. 

Click Next to proceed. 
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Figure 12: Pre – Setup information 

Step – 10 

If the option Customized Data Model is chosen, then the following panel will be displayed 

prompting the user to select the customized data model located in the machine. 

Choose the customised datamodel file from the server. 

Note:  

o The data model xml file should be available in the server. 

o If the installation is being performed on an existing information domain, the data model 

that is planned to be selected in this panel should be merged with the data model that 

was previously uploaded in the information domain. 

If the installation is being performed on a new information domain, data model that is either 

customized or merged with other data models can be selected in this panel. 

 

Figure 13: Pre – Setup information 

Step – 11 

The following panel displays pre-model upload details. 
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Verify the details before proceeding to the next step. 

Click Next to proceed for model upload. 

 

Figure 14: Pre – Model Upload Summary 

 

Click Next to start the model upload process. This process will take some time depending on 

the size of the data model and available physical memory in the environment. User will not be 

able to take any further action on the screen, until the model upload process is complete. 

Also, this step cannot be rolled back. 

If the model upload fails, then a message with relevant error and the log file path will be 

displayed. 

Review errors and take relevant action. Continue with this step until the model upload is 

successful. The installer takes the user to next step. 

Note: 

Some of the common errors during model upload are: 

o Insufficient heap memory on the client machine 

o Possible reason/resolution: The java memory settings in “reveleusstartup.sh” located in 

$FIC_APP_HOME/common/FICServer/bin directory should be increased. 

o Error while getting the Erwin File path  

o Possible reason/resolution: Restart the FICServer 

o Error in Upload Operation:  

“FAILED WHILE SUPER CATEGORY - SUB CATEGORY RELATIONS HANDLING 

DELETING” 

o Possible reason/resolution: Incorrect Erwin.xsl file version in 

$FIC_APP_HOME/common/FICServer/conf directory.  

o Incremental/Sliced model upload might give errors if there are NOT NULL columns that 

are being added to a table that already has rows or if the columns that are being dropped 

have values. Check the data model changes excel file for any such cases. In such a 

case, take a backup of the table and truncate the table. Insert records back into the table 

with a default value for the NOT NULL column. 
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Navigate to the previous screen and proceed with the steps mentioned above. 

 

Step – 12 

The following panel seeks input from the user on whether to create new ETL 

application/source pair or use an existing one. 

In case of upgrade, if customer selects an Existing application/source pair, then existing 

ETL definitions under the source will be over-written with the packaged definitions. Customer 

can also choose to create a new application/source pair and then merge the changes 

between the packaged definition and their existing definitions offline. 

Choose the required option. 

Click Next to continue. 

 

Figure 15: Pre – Setup Information 

Step 13-i 

If the option New application/source pair is chosen, then the following panel will be 

displayed asking the application and source name for creation of the same. 

Specify all the details required for application and source creation. 

Click Next to proceed. 

Click Next to create application and source within OFSAAI. Source model will also be 

generated. This process will take some time depending on the number of entities/attributes in 

the application schema. This step cannot be rolled back. 
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Figure 16: Pre – Setup Information 

 Note:  

ETL Source will be created pointing to the information domain (application schema) 

that is specified during the installation. 

 

Step 13-ii 

If the option Existing application/source pair is chosen, the following panel will be displayed 

prompting the user to select app/source pair from the list of pairs already present. 

Choose the required ETL application/source pair into which ETL definitions will be deployed. 

Click Next to proceed. 

 

Figure 17: Pre – Setup Information 

 

 

Step 14 
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Specify the OFSAAI user id. 

 

Figure 18: Pre Setup Information Screen 

Note:  

Enter the above information in upper case 

Click Next to continue. 

 

Step 15 

This panel displays all the pre-installation summary. Verify all the details and proceed. 

Click Install to proceed. 

 

Figure 19: Pre – Install Summary 

 

Step 16 

This panel displays the installation process. Wait until it completes. 
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Figure 20: Installation is in progress 

 

Step 17 

The following screen displays the completion of installation of the OFSRPA Product Setup. 

Click Done to exit. 

 

Figure 21: Installation Complete
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Machine B – Product Database Layer 

Step 1 

To begin OFSRPA product installation, execute Setup.sh. 

 

Figure 22: Installation Splash Screen 

Step 2 

 

Figure 23: Introduction Screen  

Upon invoking the installer, the Introduction screen will display the pre-requisites for 

installation. Ensure that the pre-requisites are satisfied before you proceed.   

Step 3 

Choose the log mode for this installer. Click Next to proceed. 
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Figure 24: Log Mode Option Screen 

 

Step 4 

Provide the 9 digit Customer Identification number provided during the OFSAAI installation.  

 

Figure 25: Customer ID Input Screen 

 

 

Click Next to continue.



 

21 
 

Step 5 

The Pre Setup Information screen requests for setup information.   

Select the appropriate OFSAAI layer that has been installed on the machine.  

Example Database Layer 

 

Figure 26: Pre Setup Information Screen – Choose Layer to Install 

NOTE 

o For a single-tier OFSAAI v7.3.3.3.0 installation, you must select App Layer, DB 

Layer, and Web Layer. 

o For a multi-tier OFSAAI v7.3.3.3.0 installation, select the corresponding layer 

installed on the machine.  

Step 6 

The following panel will be displayed which will prompt to select the infodom from the list of 

infodoms present in the setup. Enter the segment code and the application schema’s TNS 

name. 

Segment code should not exceed 10 characters. 
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Figure 27: Pre Setup Information Screen 

 

Step 7 

Please specify the OFSAAI user id. 

 

Figure 28: Pre Setup Information Screen 

 

Click Next to continue. 

Note:  

Enter the above information in upper case 

 

Step 8 

 

This panel displays all the pre-installation summary. Verify all the details and proceed. 

Click Install to proceed. 
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Figure 29: Pre – Install Summary 

 

Step 9 

This panel displays the installation process. Wait until it completes. 

 

Figure 30: Installation is in progress 

 

Step 10 

The following screen displays the completion of installation of the OFSRPA Product Setup. 

Click Done to exit. 



 

24 
 

 

Figure 31: Installation Complete
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Machine C – Product Web Layer 

Step 1 

To begin Oracle Financial Services Retail Performance Analytics product installation, execute 

Setup.sh. 

 

Figure 32: Installation Splash Screen 

Step 2 

 

Figure 33: Introduction Screen 

Upon invoking the installer, the Introduction screen will display the prerequisites for 

installation. Ensure that the prerequisites are satisfied before you proceed. 

Step 3 

Please choose the log mode for this installer. If Debug is selected, the Passwords will be 

printed in the Log File. 

Click Next to proceed. 
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Figure34: Log Mode Option Screen 

Step 4 

Please provide the 9 digit Customer Identification number provided during the OFSAAI 

installation. 

 

Figure35: Customer Id Input Screen 

Click Next to continue. 

Step 5 

The Pre Setup Information screen requests for setup information.  

Select the appropriate OFSAAI layer that has been installed on the machine. For example, 

Web Layer. 
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Figure 36: Pre Setup Information Screen – Choose Layer to Install 

Choose the appropriate OFSAAI layer. 

Note: 

o For a single-tier OFSAAI v7.3.3.3.0 installation, you must select App Layer, DB 

Layer and Web Layer. 

o For a multi-tier OFSAAI v7.3.3.3.0 installation, select the corresponding layer 

installed on the machine. 

Step 6 

If the option Existing Infodom is chosen in Step 6, then the following panel will be displayed 

which will prompt to select the infodom from the list of infodoms present in the setup, enter 

the segment code and enter the application schema’s TNS name. 

 

Figure 37: Pre Setup Information Screen 

Step 7 

Specify the OFSAAI user id. 
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Figure 38: Pre Setup Information Screen 

 

Note:  

Enter the above information in upper case. 

Step 8 

This panel displays the entire pre-installation summary. Verify all the details and proceed.  

Click Install to proceed. 

 

Figure 39: Pre – Install Summary 

Step 9 

This panel displays the installation process. Wait until it completes. 
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Figure 40: Installation is in progress 

 

Step 10 

The following screen displays the completion of installation of the Oracle Financial Services 

Retail performance management Product Setup.  

Click Done to exit. 

 

Figure 41: Installation Complete
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Silent Installation  
Silent installation is achieved via a properties file [Silent.props] that must be updated with 

proper values, before attempting to install using the silent mode. 

How to install in Silent Mode 

- The installer folder contains a template file “Silent.template” 

- Create a copy of this file and rename the copy as “Silent.props” 

- Edit the file “Silent.props” and specify the parameters as per the requirements 

- On the UNIX Command prompt, execute the following command 

o “Setup.sh SILENT” 

Refer to the console log [or the file preinstall.log] for any error messages. 
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The following table lists all the properties that need to be specified: 

Property Name Description of Property Permissible 

values  

Comments 

LOG_MODE Mode for logging 0 = Debug  

1= General 

Optional; 

Default : 0 

CUSTOMER_ID Customer id specified while 

installing OFSAAI 

Not Applicable MANDATORY 

INSTALL_DB Install database-tier 

components 

0 = No 

1 = Yes 

Default : 0 

INSTALL_APP Install Application-tier 

components be installed 

0 = No 

1 = Yes 

Default : 0 

INFODOM_NAME Information Domain(infodom) Not Applicable MANDATORY 

SEGMENT_CODE Segment Code Not Applicable MANDATORY 

Segment Code should 

not exceed 10 characters 

TABLESPACE Tablespace name Not Applicable MANDATORY 

INFODOM_TYPE New Infodom or Existing 

Infodom 

0 = New 

1 = Existing 

# Specify Infodom Type 

Mandatory if this an App 

Layer Installation and 

option selected for 

INSTALL_APP=1 

APPL_TNS TNS Name of the Infodom 

database 

Not Applicable MANDATORY 

APPL_USER User-id of the Database 

Schema for new Infodom 

Not Applicable # Mandatory if this an 

App Layer Installation 

and want to create a new 

infodom 

# Option selected for 

INSTALL_APP=1 and 

INFODOM_TYPE=0 

APPL_PWD Password  of the Database 

Schema for new Infodom 

Not Applicable # Mandatory if this an 

App Layer Installation 

and want to create a new 

infodom 
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# Option selected for 

INSTALL_APP=1 and 

INFODOM_TYPE=0 

APPL_URL JDBC Connection String of the 

the Database Schema for new 

Infodom 

Not Applicable # Mandatory if this an 

App Layer Installation 

and want to create a new 

infodom 

# Option selected for 

INSTALL_APP=1 and 

INFODOM_TYPE=0 

RAC_STATUS whether the Database Schema 

for new Infodom is a RAC 

database 

0 = No 

1 = Yes 

# Mandatory if this an 

App Layer Installation 

and want to create a new 

infodom 

# Option selected for 

INSTALL_APP=1 and 

INFODOM_TYPE=0 

INFODOM_DESC Description for the Database 

Schema for new Infodom 

Not Applicable # Mandatory if this an 

App Layer Installation 

and want to create a new 

infodom 

# Option selected for 

INSTALL_APP=1 and 

INFODOM_TYPE=0 

APPFTP_LOG_PATH Infodom Maintenance log 

path(to be created) for the new 

Infodom for applayer 

Not Applicable # Mandatory if this an 

App Layer Installation 

and want to create a new 

infodom 

# Option selected for 

INSTALL_APP=1 and 

INFODOM_TYPE=0 

DBFTP_LOG_PATH Infodom Maintenance log 

path(to be created) for the new 

Infodom for DB Layer 

Not Applicable # Mandatory if this an 

App Layer Installation 

and want to create a new 

infodom 

# Option selected for 

INSTALL_APP=1 and 

INFODOM_TYPE=0 

UPLOAD_MODEL whether you want to perform 

Model Upload 

0 = No 

1 = yes 

Mandatory if 

INSTALL_APP=1 
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MODEL_TYPE Released datamodel or 

Customized datamodel 

0 = released 

1 = customized 

Mandatory if 

INSTALL_APP=1 

DATAMODEL the path  for the customized 

datamodel 

Not Applicable # Mandatory only in the 

case  of uploading the 

customized datamodel 

# Option selected for 

MODEL_TYPE=1 

DM_DIRECTORY the file name for the 

customized datamodel 

Not Applicable # Mandatory only in the 

case  of uploading the 

customized datamodel 

# Option selected for 

MODEL_TYPE=1 

ETL_APP_NAME The ETL application name Not Applicable # Mandatory if this an 

App Layer installation 

# Option selected for 

INSTALL_APP=1 

ETL_SRC_NAME The ETL Source into which the 

Table-2-Table ETL definitions 

on staging tables will be 

deployed. 

Not Applicable This Source must be 

mapped to the above 

ETL Application 

ETL_APPSRC_TYPE Create new ETL App/Src pair 

or use an existing one 

0 = New 

1 = Existing 

# Mandatory if this an 

App Layer installation 

# Option selected for 

INSTALL_APP=1 

# 0 = If you want to 

create a new ETL 

app/src pair 

# 1 = If you want to use 

an existing pair 

ETL_APP_DESC Please give description for the 

ETL App 

Not Applicable # Mandatory if you want 

to create new ETL 

app/src pair 

# Option selected for 

ETL_APPSRC_TYPE=0 

ETL_SRC_DESC Please give description for the 

ETL Src 

Not Applicable # Mandatory if you want 

to create new ETL 

app/src pair 

# Option selected for 

ETL_APPSRC_TYPE=0 
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Post Installation Activities 
OFSAAI Server Memory Configuration 

The OFSAAI Application Server is started using reveleusstartup.sh. This file can be edited for 

setting customized memory settings, garbage collector settings depending on the available 

hardware configuration. 

Raise an SR in support.oracle.com if you have any queries related to EPM applications. 

Once the installation of OFSRPA Product is completed, you must perform the following steps. 

o Check the Log file (The path and file name specified in the log4j.xml).\ 

o The web.xml under the path $FIC_WB_HOME \webroot\WEB-INF\ should have Resource 

tag. If the tag is unavailable, add the tag and replace ORDEMO with the INFODOM 

name. 

o <resource-ref> 

<description>DB ConnectionORDEMO</description> 

<res-ref-name>jdbc/ORDEMO</res-ref-name> 

<res-type>javax.sql.DataSource</res-type> 

<res-auth>Container</res-auth> 

</resource-ref> 

Note: 

Copy the above information into notepad, and then copy it from notepad into xml file. 

Take extra care to avoid formatting issue. 

Configuration in Websphere Application Server 

o Create JDBC Provider for the configuration of connection pool for the above 
created Infodom (Refer to the chapter: Creating the JDBC Provider of the Oracle 
Financial Services Analytical Applications Infrastructure 7.3 Installation Manual). 

o Create a data source to access the data from the database. (Refer to the chapter: 

Creating the Data Source of the Oracle Financial Services Analytical Applications 

Infrastructure 7.3 Installation Manual). 

o After creating a Data Source, click the newly created Data Source 

($DATA_SOURCE$) and navigate to the path: 

Data sources>$DATA_SOURCE$>Connection pools  

o Set the values for Connection timeout to 0 seconds, Maximum connections to 
100 connections, and Minimum connections to 10 connections as shown in the 
below figure. 

http://support.oracle.com/
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Figure 42: Data Sources 

o Expand the Server Types under Servers option in the LHS menu. Click the WebSphere 

application servers option. This will display the Application Servers page. 

o Navigate to the Web Container option of the application server. Under Custom 

properties, add a new property com.ibm.ws.webcontainer.invokefilterscompatibility 

and set the value to true.  

o Save the new property. Use the below figure for reference. 

 

Figure 43: Application servers 

Configuration in Tomcat Application Server 

o Copy $ORACLE_HOME/jdbc/lib/ojdbc6.jar to the path: 

$TOMCAT_DIRECTORY/common/lib/ 

o Edit the server.xml present under the path $TOMCAT_DIRECTORY\conf\ with the below 

changes, which is required for connection pooling. 

Note: 

Copy the following information into notepad, and then copy it from notepad into 

xml file. Take extra care to avoid copying formatting characters into the xml file. 
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<Context path="/ $CONTEXTNAME$" docBase=" $APP_DEPLOYED_PATH$ "   
debug="0" reloadable="true" crossContext="true"> 

 <Resource auth="Container"  

  name="jdbc/ $INFODOM_NAME$" 

  type="javax.sql.DataSource" 

  driverClassName="oracle.jdbc.driver.OracleDriver" 

  username=" $ATOMICSCHEMA_USERNAME$"  

  password="$ATOMICSCHEMA_PASSWORD$"\ 

  url="$JDBC_CONNECTION_URL" 

  maxActive="100" 

  maxIdle="30" 

  maxWait="10000" 

  removeAbandoned="true" removeAbandonedTimeout="60" 

  logAbandoned="true"/> 

 </Context> 

Note: 

o $TOMCAT_DIRECTORY$ should be replaced by Tomcat application installed 
path. 

o CONTEXTNAME$ should be replaced by OFSAAI context frame. 

o $APP_DEPLOYED_PATH$ should be replaced by OFSAAI application deployed 
path. 

o $INFODOM_NAME$ should  be replaced by Infodom Name 

o $ATOMICSCHEMA_USERNAME$ should be replaced by Atomic schema 
database user name. 

o $ATOMICSCHEMA_PASSWORD$ should be replaced by Atomic schema 
database password 

o $JDBC_CONNECTION_URL should be replaced by JDBC connection string 

Example: jdbc:Oracle:thin:<IP>:<PORT>:<SID> 

jdbc:oracle:thin 10.80.50.53:1521:soluint 

o Configuration in Weblogic Application Server 

o Create JDBC Provider for the configuration of connection pool and a data 

source to access the data from the database for the above created Infodom 

(Refer to the chapter: Creating data Source – WebLogic of the Oracle Financial 

Services Analytical Applications Infrastructure 7.3 Installation Manual). 

After creating a Data Source, click the newly created Data Source 
($DATA_SOURCE$) and navigate to the path: 

Home >Summary of Services: JDBC >Summary of JDBC Data Sources>JDBC Data 
Source<INFODDOM_NAME> 

o Set the values for Initial Capacity to 10, Maximum capacity to 100 ,Capacity 

Increment by 1, Statement Cache Type to LRU, and Statement Cache size to 

10 as shown in the below figure. 

http://10.184.74.118:7001/console/console.portal?_nfpb=true&_pageLabel=HomePage1
http://10.184.74.118:7001/console/console.portal?_nfpb=true&_pageLabel=ServicesJdbcSummaryPage
http://10.184.74.118:7001/console/console.portal?_nfpb=true&_pageLabel=GlobalJDBCDataSourceTablePage
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Figure 44: Data Sources 

 

o All Oracle Financial Services Analytical Applications Infrastructure v7.3 Servers must be 

shut down. 

o Oracle 11g service must be running. 

Deploy the EAR or WAR file  

o If the Web-Server is Tomcat, then recreate and redeploy the WAR file (OFSAAI war file). 

(Refer to: Tomcat WAR Files Creation and Tomcat WAR Files Deployment of the Oracle 

Financial Services Analytical Applications Infrastructure 7.3 Installation Manual). Ensure 

that the previously deployed applications in Tomcat are removed before starting the 

redeployment. Start all the OFSAAI servers. All the servers should be directly started in 

the server. 

o If the Web-Server is Websphere, then recreate and redeploy the WAR file (OFSAAI war 

file). (Refer to: Websphere WAR Files Creation and Websphere WAR Files Deployment 

of the Oracle Financial Services Analytical Applications Infrastructure 7.3 Installation 

Manual). Ensure that the previously deployed applications in Websphere are removed 

before starting the redeployment. Start all the OFSAAI servers. All the servers should be 

directly started in the server. 

o Start all the OFSAAI v7.3 Servers. 

Note: 

o If you need assistance in starting the servers, then refer to Starting Oracle 

Reveleus Servers in the Installation Guide of Oracle Financial Services Analytical 

Applications Infrastructure 7.3. Profile should be executed before starting any 

activity from the console. 
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OFSRPA Configuration 
  

1. Make sure Oracle Business Intelligence (Version 11.1.1.7.1) installation is completed 
and available.  

 
2. Set the <Oracle BI Instance Home> directory> => e.g. 

/u01/OBIEE11G/instances/instance1.  
 

3. Start Weblogic AdminServer.   
a. Set the < BI Domain Home> directory> => e.g.  

/u01/OBIEE11G/user_projects/domains/bifoundation_domain.  
b. Navigate to < BI Domain Home >/bin and run ‘nohup ./startWebLogic.sh &’ 
c. Bringing up this service may take a few minutes depending on your 

environment.Check the logs using the command ‘tail –f nohup.out’ 
 

4. Start Node Manager.  
a. Set the < WebLogic Server Home > directory> => e.g.  

/u01/OBIEE11G/wlserver_10.3.  
b. Navigate to <WebLogic Server Home>/server/bin and  

run ‘nohup ./startNodeManager.sh &’. 
 

5. Start Weblogic Managed Server(bi_server1). 
a. Login onto http://localhost:7001/console using your Administrator credentials 

created during platform install (Replace the hostname based on your setup). 
b. Under Environment block (mid of page, towards left side), click on Servers 

link. 

 
c. The bi_server1 line should show as shutdown state at this point.  

 
d.  Click on control page tab.  

 
e. Select the bi_server1 line by clicking on the left tick box. 
f. Click Start button at the top of the list and confirm starting this service.  
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g. State will be updated to “RUNNING” mode after a few minutes.  

 
6. Start the BIEE services and login.  

a. Starting services From EM screen  
i. Login to the EM administration screen using the url 

http://localhost:7001/em (Replace the hostname and port number 
based on your setup). Use the login you created in BIEE installation 
to log in.  

ii. Expand 'Business Intelligence' node on the left and choose 
Coreapplication.  

 
iii. Click the Overview Tab,  
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iv. Click the blue button Restart (or green button Start) under the 

Manage System category, middle of screen. 
v. Click Yes on dialog box to confirm the move. Wait for message that 

confirms successful restart.  
 

b. If starting using EM is not successful and complaining about OPMNCTL not 
up, follow starting process with OPMNCTL. 

i. Open a command prompt, navigate to <Oracle BI Instance 
Home>/bin.  

ii. Run “/opmnctl status, this will show you status of all the OBIEE core 
services.  

iii. Run “/opmnctl startall” or “./opmnctl stopall” depending on your need.  
 
 

7. Deploy RPD and webcat file(s). 
a. Navigate to folder $FIC_HOME/CRMRPA/OBIEE11G/ which contains both 

CRMRPA.rpd and archived CRMRPA.catalog (contains the shared folder of 
CRMRPA application).Copy both the files to a local folder. 

b. Login to  
I. OBIEE – Enterprise Manager URL (http://<ip address>:<port>/em). 
II. Click on hyperlink ‘coreapplication’ from ‘Business Intelligence’ tab on left 

hand side. 
III. Under ‘coreapplication’, select the tab ‘Deployment’ and click ‘Lock and 

Edit Configuration’ button located below title ‘coreapplication’. Following 
screen will show up. 

 
IV. RPD Deployment: 

1. Select Browse button under Upload BI Server Repository 
section and select CRMRPA.rpd file from the local folder. Enter 
Repository password “Admin123”. 

V. Web catalog Deployment: 
1. Set the Catalog Location available under ‘BI Presentation 

Catalog’ like: 
“$ORACLE_INSTANCE/bifoundation/OracleBIPresentationServic
esComponent/$COMPONENT_NAME/catalog/CRMRPA” 

2. Click Apply and then Click Activate changes. A message will 
be shown after successful activation. 

 
 

3. Click Close and switch to Capacity management tab. 
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4. Restart the presentation services. Under the System 
Components Availability, select Presentation Services and click 
on Restart Selected option. 

 
 

VI. Once the Presentation Service is restarted, it will give the pop up for 
successful restart. Click Close. 

VII. Verify that new folder structure is created in the system. It can be found 
under path : 
 <Oracle BI Instance Home> 
\bifoundation\OracleBIPresentationServicesComponent\coreapplication_
obips1\catalog\CRMRPA 

VIII. This “CRMRPA” folder will be having a root folder which in turn contains 
three folders named “shared”, ”system”, and “users”. 

 
 

c. Open the Catalog Manager 
a. Go to File and open the catalog online (File->Open catalog) by giving the 

necessary credentials based on your setup (Type - (online), URL - 
(http://<ipaddress>:<port>/analytics/saw.dll). 

b. Once the catalog is opened, it will display a folder structure on left hand side. 
Select the shared folder under root folder in the LHS tree structure. 

c. Go to ‘File’ menu and select ‘Unarchive’. It will ask for the path for a file. 
d. Browse the path of the archived catalog file saved in your local folder using 

the Browse button in the pop up. Click OK. 
e. The catalog will be unarchived in specified location. A pop up for successful 

operation will be shown. Restart the presentation services once again. 
d. Open the analytics OBIEE URL- (http://<ipaddress>:<port>/analytics) Login with 

credentials based on your setup, and verify that catalog is available. 
 

8. Configure tnsnames.ora.  
a. Open "tnsnames.ora" file under the folder - <Oracle Home>/network/admin  
b. Make sure an entry is made in the tnsnames.ora to connect to application 

schema of OFSAA application. 
c. Save the tnsnames.ora 

  
9. Configure ODBC data source to connect to Oracle BI Server.  

 
a. Go To Control Panel>Administrative Tools>Data Sources (ODBC).  
b. Select the System DSN tab and click Add button.  
c. Select a driver specific to (Oracle BI Server 11g) and click Finish button.  
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d. Enter Name and ‘Server’ details (Specify the Host Name or IP Address of the 
BI Server and click ‘Next’).  

e. Enter Oracle BI Server login id and password (Enter User Name and 
Password created at the time of OBIEE installation). Click Next.  

f. Click Finish.  
 

10. Modify connection pool and set the properties.  
a. Open the OBI Administration tool.  
b. Select Start > Programs > Oracle Business Intelligence > BI 

Administration.  
c. Select File > Open > Online and select CRMRPA.rpd file.  
d. In the Open dialog box, select and open ‘CRMRPA.rpd’ file.  
e. Enter Repository password as “Admin123”.  
f. In the "Physical" layer, double-click the CRM Connection Pool under CRM 

Database to open its properties.  
g. In the General tab, edit / check the following entries:  
h. Call Interface: (OCI 10g/11g).  
i. Data source name: <tnsnames.ora entry created in the step 8.b connecting to 

OFSAA application schema>.  
j. User name: <enter application db user name>.  
k. Password: <enter application db user password>.  
l. Confirm password and click OK to close the window. 
m. Repeat the same for CRM Connection Pool (Init Block) 
n. In the "Physical" layer, double-click the CRM Connection Pool under CRM 

Essbase to open its properties.  
o. Essbase Server :< ip address/Hostname of the Essbase server>Username : 

<Essbase username> 
p. Password : <Essbase password> 
q. Confirm password and Click OK to close the window and click Save to save 

the RPD file.  
r. Click No for the Global Consistency Message.  
s. Close the RPD file (File/Exit).  

 
11. Login into CRMRPA Application using the URL: 

http://localhost:9704/analytics.(Replace the port number based on your setup). 
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User Roles in Customer Insight 
All the users who need access to the OFSIPA reports should have an entry in 

FSI_M_USER_MANAGER_MAP table. The table FCT_ACCOUNT_MGR_REL should have 

the necessary details for the relationship manager to account mapping. 

Prerequisites 

There are 4 types of user roles in IPA. 

o Relationship Manager Role 

o Sales Representative Role 

o Business Analyst Role 

o Administrative role 

All the users will be assigned with any of the roles mentioned above. Depending upon the 

roles, there are restrictions on the visibilities of Data, Report Pages, and Metadata. 

Data visibility 

Data visibility refers to the data control established on the results fetched by reports 
depending on the user logged in. 

For each user, only those accounts which are directly handled or are handled by a 
subordinate are visible. 

If the logged in user is an RM, then only those accounts which are associated to that user's 
organizational hierarchy will be fetched. This is achieved through 
FSI_M_USER_MANAGER_MAP table. 

If a user is Relationship Manager (RM), then the particular log in ID and the manager code 
from DIM_MANAGEMENT table have to be populated into FSI_M_USER_MANAGER_MAP 
table. 

A user logging in without any associated Manager code should have access to the entire data 
available. 

The entries to FSI_M_USER_MANAGER_MAP table have to be manually inserted. It has two 
columns, V_USERNAME and V_MANAGER_CODE. The V_USERNAME has to be inserted 
with the login username created in OBIEE and V_MANGER_CODE has to be inserted with 
the manager code of the corresponding user from DIM_MANAGEMENT table. 

Example 

The following diagram depicts a hierarchy of Relationship Managers: 
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The data visibility for each of the Relationship Managers, starting from the top of the 

hierarchy is as follows: 

o RM1 user has control over the data associated to that user along with the data 
associated to the immediate subordinates, that is, RM2, RM5, and their subordinates 
till the end of the hierarchy. 

o RM2 user has control over the data associated to that user along with the data 
associated to the immediate subordinates, that is, RM3, RM4, and their subordinates 
till the end of the hierarchy. 

o RM5 user has control over the data associated to that user along with the data 
associated to the immediate subordinate, that is, RM6 and his subordinates till the 
end of the hierarchy. 

If the logged in user is a Sales Representative (SR), the data associated with the 
opportunities managed by the respective Sales Representatives are visible. Each Sales 
Representative will have unique skey values and accounts related to those skeys are 
displayed in reports. 

If the logged in user is a Business Analyst (BA), then all the data will be fetched. 

Report visibility 

The Report’s visibility are restricted as per the below table. 

Application Role Dashboards Available 

Business Analyst o Summary 

o Customer Summary 

o Cross-Sell 

o Top 10 Opportunities 

o Opportunities 

o Activities 

o Customer Performance 
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o Product Performance 

o Line of Business Performance 

o Balance Sheet 

Relationship Manager o Opportunities 

o Activities 

o Relationship Manager Performance 

Sales Representative o Opportunities 

o Activities 

Administrator o All Reports 

The Reports visibility for the different roles has to be handled by setting proper catalog 
Permissions. The steps to setup these permissions are described in Setting Up 
Dashboard Visibility under Configure Roles and Groups of this document. 

Metadata Visibility 

Accessibility to presentation layer objects for creating ad-hoc reports varies from user-to-user 
depending on the application role the user is allocated. 

The following are the requirements for viewing the metadata in RPD: 

Application Role Tables for Ad-hoc Reporting 

Business Analyst role o Fact-Account Summary 

o Fact Account Profitability  

o Fact Opportunity 

o Fact Opportunity Activity  

o Fact Management Forecast  

o Fact Customers 

Relationship Manager role  o Fact Relationship Manager 
Contribution 

o Fact Relationship Manager 
Profitability 

o Fact Opportunity 

o Fact Opportunity Activity 

Sales Representative role  o Fact Opportunity  

o Fact Opportunity Activity 

o Fact Sales Representative 
Compensation 

Administrative role (WebLogic) o All tables 
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Configure Roles and Groups 
A detailed procedure on how to enable different roles and give permissions to different user 

roles in Enterprise manager and console are explained in this section. For controlling data 

visibility in reports, it is necessary to use the User Groups and Roles. The following procedure 

helps in configuring groups, users, and roles in Console and Enterprise Manager. 

1. Open the Admin Console of OBIEE 

2. Click Security Realms under Domain Structure. 

3. Click myrealm under Realms. 

 

4. Click User and Groups and then Groups. 

 

5. Click New and create a new group BusinessAnalysts. Click OK after providing all 

the required information for this group. 
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6. Click the newly created BusinessAnalysts group and assign the parent group. The 

Parent group determines the level of access provided to users in this user group. Allot 

the BIAuthors (this parent group give create permissions and edit permissions for the 

existing reports) parent group to this user group. 

7. Create the required number of users and allot them to this user group, after creating 

the user group and allocating a parent group to the user group. 

8. Create a new BusinessAnalyst user under Users tab of Users and Groups. Click New 

under users and provide the name of user as business analyst. 

9. Enter a password (“weblogic123”) with which this user can log in into OBIEE 

analytics. Confirm the password and move to Groups tab. 

10. Map the newly created user to respective group in the Groups tab. Assign 

“BusinessAnalysts” group created in Step 6 to this “BusinessAnalyst” user. 

11. Repeat the same procedure for all the required user groups. Create 

“SalesRepresentatives” and “RelationshipManagers” groups and then create 

“SalesRepresentative” and “RelationshipManager” users and allocate the respective 

groups to these users. All these three user groups should have “BIAuthors” as parent 

group. 

Application Roles Creation for User Groups 

Once the user groups and users are created, you can proceed with new Application roles 

creation for each user group. 

1. Open Enterprise Manager of OBIEE. 

2. Navigate to CoreApplication>Security>Single Sign On>Configure and Manage 

Application Roles. 
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3. Create a new application role with the name “BusinessAnalystRole” with display 

name as “BusinessAnalystRole” and then search for group “Business Analysts” and 

allocate this role to the respective group. 
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Follow the preceding procedure to create two new Application roles: Relationship 

ManagerRole and SalesRepresentativeRole and allocate them to respective groups. 

Setting Up Page Visibility 

1. Log into Analytics with administrator credentials and Unarchive the CRMRPA.catalog 
by selecting ACL as Preserve. 

2. After unarchiving the catalog, navigate to dashboards and expand the dashboard 
pages. 

3. Click More>Permissions. 

4. From the Permissions window, provide Read access or No Access to different 
dashboard pages foreach of the application roles created. 
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Once the access permissions are set, log in to the application using any of the user 
names, “BusinessAnalyst”/”SalesRepresentative”/”RelationshipManager” and the 
corresponding password. Check for the proper display of the dashboards. 

Note: 

The dashboards which are set to No Access from Admin login will not be 
displayed.



 

51 
 

Trouble shooting 
Problem: After logging into CRMRPA Application, if end user experiences an error as 

“Exceeded configured maximum number of allowed output prompts, sections, rows, or 

columns” while accessing reports. 

Solution:  

1. Bring down OBIEE Presentation services. 

2. Locate and take a back up of the file ’Instanceconfig.xml’ in following folder structure 

<Oracle BI Instance 

Home>\config\OracleBIPresentationServicesComponent\coreapplication_obips1 

3. Edit the file. Locate the tab ‘<view>’ which in turn contains ‘<pivot>’ tab in 

instanceconfig.xml. 

4. Paste the following lines in between ‘<pivot>’ and ‘</pivot>’ tab. 

<MaxVisibleColumns>3000</MaxVisibleColumns> 

<MaxVisiblePages>10000</MaxVisiblePages> 

<MaxVisibleRows>50000</MaxVisibleRows> 

<MaxVisibleSections>250</MaxVisibleSections> 

<DefaultRowsDisplayed>30</DefaultRowsDisplayed> 

5. Save the file and restart the presentation services. 
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Documentation 
You can download the OBIEE installation and configuration guide from   

http://www.oracle.com/technology/documentation/bi_ee.html

http://www.oracle.com/technology/documentation/bi_ee.html%0c
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